
 

 

 
 

 
 

  



 

 

 
CCC मैराथन क्लास 

Multipe Choice Objective Questions 
1. What is the primary goal of Artificial Intelligence (AI)?   

   a. Imitating human intelligence 
   b. Automating all human tasks 
   c. Creating self-aware machines 
   d. Mimicking natural processes 

आर्टिफिशियल इंिे शलजें स (एआई) का प्राथमिक लक्ष्य क्या है? 
a. िानव बु फि का अनु करण 
b. सभी िानवीय कायों को स्वचाशलत करना 
c. स्व-जागरूक ििीनें  बनाना 
d. प्राकृफतक प्रफियाओं की नकल करना 
    
 



 

 

2. Which programming paradigm is commonly associated with 
AI development? 

   a. Procedural 
   b. Object-Oriented 
   c. Functional 
   d. Logical 

कौन सा प्रोग्रामिग प्रफतिान आितौर पर AI फवकास से जुड ा है? 
a. प्रफियात्िक 
b. वस्तु के उन्िुख 
c. कायाा त्िक 
d. तार्टकक 

    
 

3. What does the term "Machine Learning" refer to in AI? 
   a. Computers learning to perform tasks without being 
explicitly programmed 
   b. Machines with mechanical learning abilities 
   c. Human learning from machines 
   d. Computers learning from humans 

  एआई िें  "ििीन लर्ननग" िब्द का क्या अथा  है? 
a. कंपू्यिर स्पष्ि रूप से प्रोग्राि फकए फबना काया  करना सीख रहे है ं
b. यांफिक सीखने की क्षिता वाली ििीनें  
c. इंसान ििीनों से सीख रहा है 
d. कंपू्यिर इंसानों से सीख रहा है 
 



 

 

4. Which of the following is an unsupervised learning 
algorithm? 

   a. Decision Trees 
   b. K-Means Clustering 
   c. Support Vector Machines 
   d. Random Forest 

फनम्नशलखखत िें  से कौन सा एक अप्रशिक्षक्षत शिक्षण एल्गोफरदि है? 
a. फनणा य के पेड  
b. के-िीन्स क्लस्िररग 
c. सिथा न वेक्िर ििीन 
d. बेतरतीब जंगल 
 
 
 
 
 के-िीन्स क्लस्िररग एक अनसुपरवाइज्ड लर्ननग एल्गोफरदि है क्षजसका 
उपयोग ििीन लर्ननग या डेिा साइंस िें  क्लस्िररग सिस्याओं को हल करने के 
शलए फकया जाता है। 
 

5. What is the purpose of a neural network's activation 
function? 

   a. To initialize the network 
   b. To introduce non-linearity 
   c. To control learning rate 
   d. To calculate loss 

तंफिका नेिवका  के सफियण ि ं क्िन का उदे्दश्य क्या है? 



 

 

a. नेिवका  आरंभ करने के शलए 
b. गैर-रैखखकता का पफरचय दे ना 
c. सीखने की दर को फनयंफित करने के शलए 
d. हाफन की गणना करने के शलए 

 
6. What does the acronym "NLP" stand for in the context of AI? 

   a. Natural Language Processing 
   b. Neural Learning Platform 
   c. Nonlinear Programming 
   d. Networked Language Protocol 

एआई के संदभा  िें  "एनएलपी" का संक्षक्षप्त रूप क्या है? 
a. प्राकृफतक भाषा प्रसंस्करण 
b. तंफिका शिक्षण िंच 
c. नॉनलीफनयर प्रोग्रामिग 
d. नेिवका  भाषा प्रोिोकॉल 
 

 
7. Which technique is used for reducing the dimensionality of 
data in machine learning? 

   a. Clustering 
   b. Dimensionality Reduction 
   c. Feature Scaling 
   d. Ensemble Learning 

ििीन लर्ननग िें  डेिा की आयािीता को कि करने के शलए फकस तकनीक का 
उपयोग फकया जाता है? 

a. क्लस्िररग 



 

 

b. आयािीता िें  किी 
c. ि ीचर स्केललग 
c. सीखना सिूह 
 
 

8. What is the purpose of the "ReLU" activation function in 
neural networks? 

   a. Ensure network convergence 
   b. Introduce non-linearity 
   c. Normalize input data 
   d. Prevent overfitting 

तंफिका नेिवका  िें  "ReLU" सफियण ि ं क्िन का उदे्दश्य क्या है? 
a. नेिवका  अमभसरण सुफनफश्चत करें  
b. गैर-रैखखकता का पफरचय दें  
c. इनपु ि डेिा को सािान्यीकृत करें  
d. ओवरफिरिग रोकें  
 
 

9. What is the "Turing Test" designed to assess? 
   a. Memory capacity of machines 
   b. Creativity in AI 
   c. Natural language understanding and intelligence 
   d. Processing speed of computers 

"ट्यूररग िे स्ि" फकसका आकलन करने के शलए फडज ाइन फकया गया है? 
a. ििीनों की िेिोरी क्षिता 
b. एआई िें  रचनात्िकता 



 

 

c. प्राकृफतक भाषा की सिझ और बु फि 
d. कंपू्यिर की प्रोसेससग गफत    
 

10. Which algorithm is often used for reinforcement learning? 
    a. Naive Bayes 
    b. Q-Learning 
    c. K-Nearest Neighbors 
    d. Linear Regression 

 सुदृढीकरण सीखने के शलए अक्सर फकस एल्गोफरदि का उपयोग फकया जाता है? 
a. नादान बेयस 
b. क्यू-लर्ननग 
c. K-फनकिति पड ोसी 
d. रे खीय प्रफतगिन 

 
11. In the context of machine learning, what does "overfitting" 
mean? 

    a. The model is too simple 
    b. The model is too complex and fits the training data too 
closely 
    c. The model is undertrained 
    d. The model cannot generalize to new data 

ििीन लर्ननग के संदभा  िें , "ओवरफिरिग" का क्या अथा  है? 
a. िॉडल बहु त सरल है 
b. िॉडल बहु त जफिल है और प्रशिक्षण डेिा पर बहु त बारीकी से फिि बैठता है 
c. िॉडल को प्रशिक्षक्षत फकया गया है 
d. िॉडल नए डेिा का सािान्यीकरण नहीं कर सकता 



 

 

 
12. What does the term "Chatbot" refer to in AI? 

    a. A robot that can chat with humans 
    b. A program that simulates conversation with users 
    c. A computer with a chatting interface 
    d. A machine learning algorithm 

AI िें  "चैिबॉि" िब्द का क्या अथा  है? 
a. एक ऐसा रोबोि जो इंसानों से चैि कर सकता है 
b. एक प्रोग्राि जो उपयोगकताा ओं के साथ बातचीत का अनु करण करता है 
c. चैरिग इंिरि े स वाला एक कंपू्यिर 
d. एक ििीन लर्ननग एल्गोफरदि 

13. Which type of learning involves learning from feedback, 
using a reward system? 

    a. Supervised Learning 
    b. Unsupervised Learning 
    c. Reinforcement Learning 
    d. Semi-Supervised Learning 

 फकस प्रकार की शिक्षा िें  पु रस्कार प्रणाली का उपयोग करके िीडबैक से सीखना 
िामिल है? 

a. पया वेक्षक्षत अध्ययन 
b. फबना पया वेक्षण के सीखना 
c. सुदृढीकरण सीखना 
d. अर्ा -पया वेक्षक्षत शिक्षण 
 
 

 



 

 

 
14. What is the purpose of the "Bias" term in a neural network? 

    a. To reduce computational complexity 
    b. To introduce randomness 
    c. To control model flexibility 
    d. To shift the output activation function 

तंफिका नेिवका  िें  "पूवाा ग्रह" िब्द का उदे्दश्य क्या है? 
a. कम्पू्यिे िनल जफिलता को कि करने के शलए 
b. यादृफिकता का पफरचय दे ना 
c. िॉडल लचीलेपन को फनयंफित करने के शलए 
d. आउिपु ि सफियण ि ं क्िन को स्थानांतफरत करने के शलए     
 

15. Which of the following is a subfield of AI that focuses on 
mimicking human thought processes? 

    a. Machine Learning 
    b. Natural Language Processing 
    c. Cognitive Computing 
    d. Computer Vision 

फनम्नशलखखत िें  से कौन सा AI का एक उपके्षि है जो िानव फवचार प्रफियाओं की 
नकल करने पर कें फित है? 

a. यंि अक्षर्गि 
b. प्राकृफतक भाषा प्रसंस्करण 
c. संज्ञानात्िक कंपू्यरिग 
d. कंपू्यिर दृफष्ि 
 
 



 

 

 
16. What is the significance of the term "Big Data" in the 
context of AI? 

    a. Large datasets that can be processed using traditional 
methods 
    b. Massive volumes of data that require advanced 
analytics 
    c. Data that is too small for machine learning applications 
    d. The storage capacity of AI systems 

एआई के संदभा  िें  "फबग डेिा" िब्द का क्या िहत्व है? 
a. बड े  डेिासेि क्षजन्हें  पारंपफरक तरीकों का उपयोग करके संसाक्षर्त फकया जा 
सकता है 
b. भारी िािा िें  डेिा क्षजसके शलए उन्नत फवश्लेषण की आवश्यकता होती है 
c. डेिा जो ििीन लर्ननग अनु प्रयोगों के शलए बहु त छोिा है 
d. एआई क्षसस्िि की भंडारण क्षिता   

 
17. Which algorithm is often used for image recognition in deep 
learning? 

    a. Naive Bayes 
    b. Support Vector Machines 
    c. Convolutional Neural Networks (CNN) 
    d. Decision Trees 

गहन शिक्षण िें  छफव पहचान के शलए अक्सर फकस एल्गोफरदि का उपयोग फकया 
जाता है? 

a. नादान बेयस 
b. सिथा न वेक्िर ििीन 



 

 

c. संवादात्िक तंफिका नेिवका  (सीएनएन) 
d. फनणा य के पेड  

 
18. What is the primary challenge in Natural Language 
Processing (NLP)? 

    a. Image recognition 
    b. Speech synthesis 
    c. Understanding and interpreting human language 
    d. Data storage 

प्राकृफतक भाषा प्रसंस्करण (एनएलपी) िें  प्राथमिक चुनौती क्या है? 
a. छफव पहचान 
b. भाषा संकलन 
c. िानव भाषा को सिझना और उसकी व्याख्या करना 
d. आर्ार सािग्री भंडारण 

 
19. Which method is commonly used for feature scaling in 
machine learning? 

    a. Z-score normalization 
    b. Min-Max scaling 
    c. Principal Component Analysis (PCA) 
    d. Gradient Descent 

ििीन लर्ननग िें  िीचर स्केललग के शलए आितौर पर फकस फवक्षर् का उपयोग 
फकया जाता है? 

a. Z-स्कोर सािान्यीकरण 
b. न्यूनति-अक्षर्कति स्केललग 
c. प्रर्ान घिक फवश्लेषण (पीसीए) 



 

 

d. ढतला हु आ वंि 
 

20. What is the role of the "Loss Function" in the training of a 
machine learning model? 

    a. To measure the accuracy of the model 
    b. To minimize the difference between predicted and 
actual values 
    c. To control the learning rate 
    d. To initialize the weights of the model 

 ििीन लर्ननग िॉडल के प्रशिक्षण िें  "लॉस िंक्िन" की क्या भूमिका है? 
a. िॉडल की सिीकता िापने के शलए 
b. अनु िाफनत और वास्तफवक िूल्यों के बीच अंतर को कि करना 
c. सीखने की दर को फनयंफित करने के शलए 
d. िॉडल के वजन को आरंभ करने के शलए 
 

21. Which of the following is NOT a primary color for additive 
color mixing? फनम्नशलखखत िें  से कौन सा योगात्िक रंग मिश्रण के शलए 
प्राथमिक रंग नहीं है? 
   a) Red 
   b) Blue 
   c) Green 
   d) Yellow 
 
22. Which of the following is a volatile memory? 
 फनम्नशलखखत िें  से कौन सी एक अफस्थर िेिोरी है? 



 

 

   a) ROM 
   b) RAM 
   c) Hard disk 
   d) Flash memory 
 
23. Which of the following is a network topology? 
फनम्नशलखखत िें  से कौन एक नेिवका  िोपोलॉजी है? 
    a) HTML 
    b) CSS 
    c) Star 
    d) JavaScript 
 
24. What is the file extension for a Microsoft Word document? 
Microsoft Word दस्तावेज  के शलए ि ाइल एक्सिें िन क्या है? 
    a) .docx 
    b) .txt 
    c) .xlsx 
    d) .pptx 
 
25. Which of the following is an example of a spreadsheet 
software? फनम्नशलखखत िें  से कौन सा स्पे्रडिीि सॉफ़ िवेयर का उदाहरण है? 
    a) Libre office writer 
    b) Libre office Calc 
    c) Adobe Photoshop 



 

 

    d) Google Chrome 
 
26. What is the purpose of an IP address?  
    a) To identify a computer on a network 
    b) To store files and folders 
    c) To browse the internet 
    d) To send emails 
IP पते का उदे्दश्य क्या है? 
a. फकसी नेिवका  पर कंपू्यिर की पहचान करना 
b. ि ाइलों और ि ोल्डरों को संग्रहीत करने के शलए 
c. भुगतान का प्रयोजन 
d. ईिेल भेजने के शलए 
 
27. What is the default port number for HTTP? 
HTTP के शलए फडि ॉल्ट पोिा  नंबर क्या है? 
    a) 80 
    b) 443 
    c) 22 
    d) 53 
 
28. Which of the following is a database management system? 
फनम्नशलखखत िें  से कौन सा डेिाबेस प्रबंर्न प्रणाली है? 
    a) Microsoft Word 
    b) Photoshop 



 

 

    c) MySQL 
    d) Google Chrome 
 
29. What does the acronym SQL stand for? 
SQL का िुल िॉिा  क्या है? 
    a) Structured Query Language 
    b) Simple Query Language 
    c) System Query Language 
    d) Standard Query Language 
 
30. Which of the following is NOT an example of a cloud storage 
service?  
फनम्नशलखखत िें  से कौन सा क्लाउड स्िोरे ज सेवा का उदाहरण नहीं है? 
    a) Google Drive 
    b) Dropbox 
    c) iCloud 
    d) Microsoft Word 
31. What is the purpose of a DNS server? 
DNS सवा र का उदे्दश्य क्या है? 
    a) To convert domain names to IP addresses 
    b) To provide email services 
    c) To secure network connections 
    d) To store website files 
 



 

 

 
32. Which of the following is NOT an example of an object-
oriented programming language? 
फनम्नशलखखत िें  से कौन ऑब्जेक्ि-ओफरएंिे ड प्रोग्रामिग भाषा का उदाहरण नहीं है? 
    a) Java 
    b) C++ 
    c) Python 
    d) Fortran 
 
33. What is the purpose of an index in a database? 
डेिाबेस िें  इंडेक्स का उदे्दश्य क्या है? 

a) To organize and optimize data retrieval/ डेिा पु नप्राा फप्त को 
व्यवफस्थत और अनु कूशलत करना 
b) To secure data from unauthorized access/ अनक्षर्कृत पहु ं च से 
डेिा को सुरक्षक्षत करने के शलए 
c) To format data for presentation/ पे्रजें िे िन के शलए डेिा को ि ॉिेि 
करना 

    d) To store and manage data/ डेिा को स्िोर और प्रबंक्षर्त करना 
 
34. Which of the following is a web browser? 
फनम्नशलखखत िें  से कौन सा एक वेब ब्राउज र है? 
    a) Google 
    b) Yahoo 
    c) Chrome 



 

 

    d) All of the above 
 
35. What is the purpose of a conditional statement in 
programming? 
प्रोग्रामिग िें  सिता  कथन का उदे्दश्य क्या है? 
    a) To perform different actions based on a condition 
    b) To calculate mathematical expressions 
    c) To store data temporarily 
    d) To create loops 
 
36. What does URL stand for? यूआरएल का ितलब क्या है? 
    a) Uniform Resource Locator 
    b) Universal Reference Locator 
    c) Unified Retrieval Link 
    d) User Required Location 
 
37. What is the purpose of a cookie in web development? 
वेब फवकास िें  कुकी का उदे्दश्य क्या है? 
    a) To store user preferences and session information/) 
उपयोगकताा  की प्राथमिकताओं और सि की जानकारी संग्रहीत करने के शलए 
    b) To encrypt data transmitted over the internet/ इंिरनेि पर 
प्रसाफरत डेिा को एफन्िप्ि करने के शलए 
    c) To format web pages for presentation/ पे्रजें िे िन के शलए वेब 
पेजों को प्रारूफपत करना 



 

 

    d) To block unwanted websites/ अवांमछत वेबसाइिों को ब्लॉक करने 
के शलए 
 
38. Which of the following is a programming language 
commonly used for data analysis and scientific computing? 
फनम्नशलखखत िें  से कौन सी प्रोग्रामिग भाषा आितौर पर डेिा फवश्लेषण और 
वैज्ञाफनक कंपू्यरिग के शलए उपयोग की जाती है? 
    a) Java 
    b) Python 
    c) C++ 
    d) SQL 
 
39. What is the purpose of a compiler in programming? 
प्रोग्रामिग िें  कंपाइलर का उदे्दश्य क्या है? 
    a) To translate source code into machine code 
    b) To execute code 
    c) To debug code 
    d) To format data for presentation 
 
40. Which of the following is NOT an example of a database 
management system? 
फनम्नशलखखत िें  से कौन सा डेिाबेस प्रबंर्न प्रणाली का उदाहरण नहीं है? 
    a) MySQL 
    b) Oracle 



 

 

    c) Photoshop 
    d) Microsoft SQL Server 
 
41. How can you add a slide transition in LibreOffice Impress? 
आप शलबरऑफिस इम्पे्रस िें  स्लाइड ट्ांक्षज िन कैसे जोड  सकते है?ं 

    a) Right-click on the slide and choose "Slide Transition " 

    b) Go to the "Slide" menu and select “Transition" 

    c) Use the slide transition options in the sidebar pane 

    d) All of the above 

42. How can you apply a different slide layout to a slide in 
LibreOffice Impress? 
आप शलबरऑफिस इम्पे्रस िें  एक स्लाइड पर एक अलग स्लाइड लेआउि कैसे लागू 
कर सकते है?ं 

   a) Right-click on the slide and choose "Slide Layout" 

   b) Go to the "Slide" menu and select "Slide Layout" 

   c) Both of these 

   d) Non of these 

 

 

 

 



 

 

43. How can you insert an image into a slide in LibreOffice 
Impress? 
आप शलबरऑफिस इम्पे्रस िें  स्लाइड िें  एक छफव कैसे सफम्िशलत कर सकते है?ं 

   a) Drag and drop the image onto the slide 

   b) Go to the "Insert" menu and select "Image" 

   c) Use the image icon in the toolbar 

   d) All of the above 

 

44. How can you add animations to objects on a slide in 
LibreOffice Impress? 
आप शलबरऑफिस इम्पे्रस िें  स्लाइड पर ऑब्जेक्ि िें  एफनिेिन कैसे जोड  सकते 
है?ं 

   a) Right-click on the object and choose "Animation" 

   b) Go to the "Insert" menu and select “Animation" 

   c) Use the animation options in the sidebar pane 

   d) All of the above 

 

45. How can you start a presentation in LibreOffice Impress? 
आप शलबे्र ऑफिस इम्पे्रस िें  पे्रजें िे िन कैसे शुरू कर सकते है?ं 

   a) Press F5 



 

 

   b) Go to the "Slide Show" menu and select "Start from first 
slide" 

   c) Both a and b 

   d) None of thes 

 

46. How can you save a presentation in LibreOffice Impress?  
आप शलबरऑफिस इम्पे्रस िें  पे्रजें िेिन कैसे सेव कर सकते है?ं 

    a) Go to the "File" menu and select "Save" 

    b) Press Ctrl+S 

    c) Use the floppy disk icon in the toolbar 

    d) All of the above 

47. How can you export a presentation to PDF format in 
LibreOffice Impress? 

    a) Go to the "File" menu and select "Export as PDF" 

    b) Use the PDF icon in the toolbar 

    c) Both a. and b. 

    d) Press Ctrl+Shift+E 

 

 



 

 

48. How can you add a hyperlink to a slide in LibreOffice 
Impress? 
आप शलबरऑफिस इम्पे्रस िें  फकसी स्लाइड िें  हाइपरललक कैसे जोड  सकते है?ं 

    a) Right-click on the slide and choose "Hyperlink" 

    b) Go to the "Insert" menu and select "Hyperlink" 

    c) Use the hyperlink options in the sidebar pane 

    d) None of these 

49. How can you hide a slide in LibreOffice Impress? 
आप शलबरऑफिस इम्पे्रस िें  स्लाइड को कैसे मछपा सकते है?ं 

    a) Right-click on the slide and choose "Hide Slide" 

    b) Go to the "Slide" menu and select "Hide Slide" 

    c) Both a. and b. 

    d) All of the above 

 
50. Which of the following is not an operating system? 
फनम्नशलखखत िें  से कौन सा एक ऑपरे रिग क्षसस्िि नहीं है? 
   a) Windows 
   b) Linux 
   c) Microsoft Office 
   d) macOS 
 
 



 

 

 
51. What is the main function of an operating system? 
ऑपरे रिग क्षसस्िि का िुख्य काया  क्या है? 
   a) Manage hardware resources 
   b) Run applications 
   c) Connect to the internet 
   d) Create documents 
 
52. Which operating system is open-source? 
कौन सा ऑपरे रिग क्षसस्िि ओपन-सोसा  है? 
   a) Windows 
   b) macOS 
   c) Linux 
   d) Android 
 
53. What is the full form of GUI? 
GUI का िुल िॉिा  क्या है? 
   a) General User Interface 
   b) Graphical User Interface 
   c) Graphic User Interface 
   d) General User Interaction 
 
 
 
54. Which command is used to change the current directory in 
a command-line interface? 



 

 

किांड-लाइन इंिरि े स िें  वता िान फनदे शिका को बदलने के शलए फकस किांड का 
उपयोग फकया जाता है? 
    a) ls 
    b) cd 
    c) pwd 
    d) mkdir 
 
 
55. Which type of file system is commonly used in UNIX-like 
operating systems? 
UNIX जैसे ऑपरे रिग क्षसस्िि िें  आितौर पर फकस प्रकार की ि ाइल प्रणाली का 
उपयोग फकया जाता है? 
    a) FAT32 
    b) NTFS 
    c) ext4 
    d) HFS+ 
 
 
 
55. What is the purpose of the "chmod" command in UNIX-like 
operating systems? 
UNIX जैसे ऑपरे रिग क्षसस्िि िें  "chmod" किांड का उदे्दश्य क्या है? 
    a) Change the ownership of a file 
    b) Change the file extension 
    c) Change the permissions of a file 
    d) Change the file's timestamp 



 

 

 
 
56. What is the purpose of a shell in an operating system? 
फकसी ऑपरे रिग क्षसस्िि िें  िेल का उदे्दश्य क्या है? 
    a) To manage memory allocation 
    b) To provide a graphical user interface 
    c) To interpret and execute commands 
    d) To schedule processes 
 
 
िेल आपको इनपु ि के शलए संकेत दे कर, ऑपरे रिग क्षसस्िि के शलए उस इनपु ि 
की व्याख्या करके और फिर ऑपरे रिग क्षसस्िि से फकसी भी पफरणािी आउिपु ि 
को संभालकर आपके और ऑपरे रिग क्षसस्िि के बीच बातचीत का प्रबंर्न करता 
है। िेल्स आपको ऑपरे रिग क्षसस्िि के साथ संचार करने का एक तरीका प्रदान 
करते है।ं 
The shell manages the interaction between you and the 
operating system by prompting you for input, interpreting that 
input for the operating system, and then handling any 
resulting output from the operating system. Shells provide a 
way for you to communicate with the operating system. 
 
 
 
 
 
 



 

 

57. Which command is used to display the IP address 
configuration of a computer in Windows? 
रवडोज  िें  कंपू्यिर के आईपी एडे्रस कॉफन्ि गरे िन को प्रदर्शित करने के शलए फकस 
किांड का उपयोग फकया जाता है? 
    a) ifconfig 
    b) ipconfig 
    c) ping 
    d) netstat 
 
 
58. फनम्नशलखखत िें  से फकस िैन्यु िें  टै्क चें ज फवकल्प िौजूद होता है? Track 

change option is present in which of the following menu? 
a. File  
b. Edit 
c. Insert 
d. Format 

 
 
59. PAN का िुल िॉिा  क्या होता है? What is the full form of PAN? 

a. Permanent Account Number 
b. Permanent Address Number 
c. Public Account Number 
d. None of these 

 
 
 



 

 

 
60. Wi-Fi िें  कि से कि पासवडा  फकतना रख सकते है? What is the 

minimum password you can keep in Wi-Fi? 
a. 10 
b. 6 
c. 7 
d. 8 

 
61. TCP/IP िें  फकतनी लेयर होती है? How many layers do TCP / IP 

have? 
A. 4  
B. 5 
C. 6 
D. 7 

 
62. MIME का पूणा  अथा  है ? 

What is the full meaning of MIME? 
a) िल्टीपरपज इंिरनेि एक्सिें िन  
b) िल्टीपल इंिरनेि िेल एक्सिें िन  
c) िल्टीपल इंिरनेिनल िेल एक्सिें िन  
d) कोई नही  

 
 
63. ईिेल एकाउंि का स्िोरे ज एफरया जहााँ  सभी िेल स्िोर होती है उसे .... कहते 

है ? 



 

 

The storage area of an email account where all mail is 
stored. That is called_____? 
a) अिैचिें ि  
b) हाइपरललक  
c) िेलबोक्स  
d) एडे्रसबु क  

 
64.  ई-िेल का पहल भाग ......को बताता है? 

The first part of an e-mail refers to ……? 
a) डोिेन नेि  
b) यूजर नेि  
c) आईएसपी  
d) फनवास का पता  

 
65.  फनम्न िें  से कौन सा ई-िेल क्लाइंि है ? 

Which of the following is an e-mail client? 
a) आउिलुक  
b) इंिरनेि एक्सप्लोरर  
c) नेिस्केप  
d) कोई नही  

 
 
66. ई-िेल भेजने के शलए ....बिन को फक्लक करे  ? 

To send e-mail click on the .... button? 
a) फ़ॉरवडा   
b) सें ड  



 

 

c) फरप्लाई  
d) फडलीि  

 
 
67. प्राप्त िेल को फकसी दूसरे  को भेजने के शलए ... पर फक्लक करे  ? 

To send the received mail to someone else, click on ... ? 
a) फरप्लाई  
b) फरप्लाई ऑल 
c) िारवडा  
d) सें ड  

 
68. UHID नंबर का िुल िॉिा  क्या होता है  

What is the full form of UHID number 
a) Universal Health Identification  
b) Union Health Identification  
c) Unique Health Identification  
d) None of these 

 
 
69. फनम्न िें  से कौन सा फनशुल्क वेब आर्ाफरत ई-िेल सेवा प्रदाता है? 

Which of the following is a free web based e-mail service 
provider? 
a) www.yahoo.com  
b) www.gmail.com 
c) दोनों 
d) None  



 

 

 
 
70.  G2G का पूरा नाि Government to Government है? 

The full name of G2G is Government to Government? 
a) True 
b) False 

 
 
71. UMANG एप िें  N का पूरा नाि क्या है? 

What is the full name of N in UMANG app? 
a) New 
b) Now  
c) New Age 
d) None 

 
72. आर्ार काडा  फकसके द्वारा जारी फकया गया है? 

Aadhar card is issued by whom? 
a) UIDAI 
b) RBI 
c) None 
d) Both a. and b. 

 
73. आप एक दोस्त के साथ तत्काल ,वास्तफवक सिय संचार के शलए क्या 

उपयोग करें गे?  
What would you use for instant, real-time communication 
with a friend? 



 

 

a) इंस्िें ि िेसेसजग 
b) ईिेल  
c) यूजनेि  
d) ब्लॉग  

 
74. NeGP कब लांच फकया गया? 

When was NeGP launched? 
a) 18 May 2006 
b) 17 May 2007 
c) 10 May 2006 
d) 11 May 2006 

 
 
75. UPI पेिें ि इंिरिेस ...........द्वारा फवकक्षसत की गयी? 

UPI Payment Interface was developed by 
a) National Payment Corporation  
b) Finance Mini  
c) Bank  
d) None  

 
76.  बैकं फकस पर व्याज दे ता है ?  

What does the bank pay interest on? 
a) None/ कोई नही  
b) Deposits/ जिाओं 
c) Both Deposits and Loans/ दोनों जिाओं एवं ऋणो  
d) Loans/ ऋणों 



 

 

 
77.  पेयी चेक का भुगतान फकया जा सकता है ? 

Can a payee check be paid? 
a) बैकं के नकद काउंिर पर  
b) एिीएि द्वारा  
c) बैकं खाते िें  जिा करके  
d) कोई नही  

 
78.  चैक की वैर्ता अवक्षर् होती है ? 

What is the validity period of check? 
a) 4 Month from date of issue  
b) 3 Month from date of issue 
c) 1 Month from date of issue 
d) Unlimited  

 
79. बैकं लोंन नही दे ती है ?  

Bank does not give loan? 
a) Gold Ornaments  
b) LIC Policy  
c) Lottery ticket  
d) NSC  

 
 
 
 
 



 

 

80.  AEPS स्िैडं करता है Aadhaar Enabled Payment System? 
AEPS stands for Aadhaar Enabled Payment System 
a) True 
b) False 

 
81. POS है? 

POS is? 
a) Point of Sale/ प्वाइंि ऑफ़ सेल  
b) Position of Sale/ पोजीिन ऑफ़ सेल  
c) Picture of Sale/ फपक्चर ऑफ़ सेल  
d) None / कोई नही 

 
 
82. वन िाइि पासवडा  क्यों सुरक्षक्षत है? 

Why is One Time Password Safe? 
a) यह जनरे ि करना आसन है 
b) इसको िेयर नही कर सकते  
c) यह हर एके्सस के शलए मभन्न है  
d) यह एक जफिल एनफिप्िेड पासवडा  है  

 
83.  इनिे से कौन सी िोबाइल बैरंकग सेवा है? 

Which of the following is a mobile banking service? 
a) बैलें स की जांच  
b) खाता लेन दे न 
c) भुगतान  
d) सभी  



 

 

 
84.  RTGS का पूणा  रूप है – 

The full form of RTGS is - 
a) फरयल िाइि गें  सेिलिें ि  
b) फरयल िाइि ग्रास सेिलिें ि  
c) फरयल िाइि ग्रांस स्िे ििें ि  
d) रोिे िनल ट्ांजैक्िन गें  स्िे ििें ि   

 
85. आर्ार सीरडग क्या है? 

What is Aadhaar Seeding? 
a) बैकं खाते से आर्ार जोड़ना  
b) आर्ार काडा  को पोस्ि ऑफिस से जोड़ना  
c) आर्ार काडा  को गैस कनेक्िन से जोड़ना  
d) कोई नही  

 
86.  भारतीय िुिा मचन्ह आक्षर्काफरक तौर पर अपनाया गया?- 

Indian currency symbol officially adopted? 
a) 5 अगस्त 2010 
b) 11 जुलाई 2010 
c) 13 जुलाई 2010 
d) 15 जुलाई 2010 

 
87.  बैरंकग के्षि िें  अक्षर्क संख्या िें  चेको के तेज फनस्तारण के शलए 

फनम्नशलखखत िें  से कौन प्रयुक्त होता है? 
Which of the following is used in the banking sector for 
faster settlement of large number of Cheques? 



 

 

a) Bar Code Reader 
b) OCR 
c) MICR  
d) OMR  

 
88. IMPS Stand for – 

IMPS Stand for - 
a) इिीफडएि पेिें ि सर्टवस  
b) इिीफडएि पे सर्टवस 
c) इिीफडएि पेिें ि क्षसस्िि 
d) कोई नही  

 
89.  नेि बैरंकग की सुफवर्ा कौन कौन से बैकं प्रदान करती है? 

Which banks provide the facility of net banking? 
a) स्िे ि बैन ऑफ़ इफडडया  
b) एच डी एि सी बैकं  
c) बैकं ऑफ़ बडौदा  
d) सभी  

 
 
90.  एिीएि कि डेफबि काडा  पर िुफित संख्या िें  फकतने अंक है? 

How many digits are there in the number printed on the ATM 
cum Debit card? 
a) 12 
b) 14 
c) 16 



 

 

d) 10 
 
 
 
91. यफद कोई ििीन बाहरी वातावरण के आर्ार पर अपनी काया प्रणाली को 

स्वयं बदल सकती है, तो ििीन को क्या कहा जाता है? 
If a machine can change its course of action based on the 
external environment on its own, the machine is called? 

a. Machine/ ििीन 
b. Intelligent/बु फििान 
c. Hardware/हाडा वेयर 
d. None/कोई नहीं 

 
92. आर्टिफिशियल इंिे शलजें स के शलए फनम्नशलखखत िें  से कौन सी सािान्य 

भाषा है? 
Which of the following is the common language for Artificial 
Intelligence? 

a. Python 
b. Java 
c. PHP 
d. Cobol 

 
 
93. फनम्नशलखखत िें  से कौन सा कृफिि बु फिित्ता का अनु प्रयोग नहीं है? 

Which of the following is not an application of artificial 
intelligence? 



 

 

a. Natural Language Processing 
b. Database Management System 
c. Digital Assistant 
d. Computer Vision 

 
 
94. फनम्नशलखखत िें  से कौन सा एक प्रकार का कृफिि बु फिित्ता एजें ि है? 

Which of the following is a type of artificial intelligence 
agent? 

a. Simle AI agent 
b. Learning AI agent 
c. Goal-Based AI agent 
d. All of the above 

 
95. आर्टिफिशियल इंिे शलजें स दृफष्िकोण के फवमभन्न प्रकार क्या है?ं 

What are the different types of Artificial Intelligence 
approaches? 

a. Strong Approach 
b. Weak Approach 
c. Applier Approach 
d. All of the above 

 
96. फनम्नशलखखत िें  से फकस आर्टकिेक्चर को क्षसस्िोशलक ऐरे  के रूप िें  भी जाना 

जाता है? 
Which of the following architecture is also known as systolic 
arrays? 



 

 

a. MISD 
b. SISD 
c. SIMD 
d. None of these 

 
97. एक AI एजें ि अपने पयाा वरण के साथ कैसे इंिरैक्ि करता है? 

How an AI agent does interacts with its environment? 
a. Using sensors and perceivers 
b. Using only sensors 
c. Using only perceivers 
d. None of the above 

 
 
98. फनम्नशलखखत िें  से कौन सी आर्टिफिशियल इंिे शलजें स की िाखा है? 

Which of the following is the branch of Artificial 
Intelligence? 

a. Machine Learning 
b. Cyber forensics 
c. Full-Stack Developer 
d. Network Design 

 
 
 
99. आर्टिफिशियल इंिे शलजें स का लक्ष्य क्या है?  

What is the goal of Artificial Intelligence? 



 

 

a. To solve artificial problems/ कृफिि सिस्याओं का सिार्ान 
करना 

b. To extract scientific causes/ वैज्ञाफनक कारण फनकालना 
c. To explain various sorts of intelligence/ बु फि के फवमभन्न 

प्रकारों की व्याख्या करना 
d. To solve real-world problems/ वास्तफवक दु फनया की सिस्याओं 

को हल करने के शलए 
 
 
100. फनम्नशलखखत िें  से फकस पैरािीिर के आर्ार पर आर्टिफिशियल इंिे शलजें स 

को वगीकृत फकया गया है? 
Based on which of the following parameter Artificial 
Intelligence is categorized? 

a. केवल कायाा त्िकता पर आर्ाफरत है/ Based on functionally only 
b. केवल क्षिताओं के आर्ार पर/ Based on capabilities only 
c. क्षिताओं और कायाा त्िकता के आर्ार पर/ Based on capabilities 

and functionally 
d. इसे वगीकृत नहीं फकया गया है/ It is not categorized 
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